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Introducing MAUI® Studio and MAUI® Studio Pro

About MAUI Studio
MAUI Studio puts the Teledyne LeCroy MAUI oscilloscope software on your desktop for offline analysis of waveform
files and LabNotebooks.

It also enables you to open and analyze waveform files saved on Tektronix, Keysight, Rohde & Schwarz or Yokogawa
instruments using the rich, Teledyne LeCroy standard toolbox of cursors, measurement parameters and math
functions.

MAUI Studio mimics the user interface of an HDO4024A oscilloscope, a 4-channel, 12-bit High Definition
Oscilloscope with most of the features available on higher-bandwidth oscilloscopes such as:

l User-defined measurement parameters and math functions

l Multi-grid display

l Windows 10 security and file functions

When using MAUI Studio, you will be able to open LabNotebooks or waveform (.trc) files and analyze them using the
tools that would be found on a standard HDO4024A. Any information in the files outside the capabilities of an
HDO4024A (e.g., long memory record data, grid modes, Q-Scape display modes, math/measurements, histogram
data) is simply truncated or ignored.

MAUI Studio is offered complimentary to Teledyne LeCroy oscilloscope customers.

About MAUI Studio Pro
MAUI Studio Pro is a purchased software package that extends MAUI Studio with these key capabilities:

l Universal Oscilloscope Simulation—you can choose to simulate the model type and standard features of
dozens of past and current Teledyne LeCroy oscilloscopes to take advantage of their capabilities. The MAUI
Studio Pro user interface will appear as it does on that oscilloscope with the latest, Windows 10 version of the
MAUI oscilloscope software installed.

l LabNotebook with "Portable Software Options"—when you recall a LabNotebook, you recall not only acquisition
setup and waveform data, but the entire "personality" of the oscilloscope on which the LabNotebook was saved,
including all of its software options, as well as standard features. This enables you to conduct offline analysis of
that LabNotebook exactly as if it were being conducted on the oscilloscope—only from the comfort of your
home/office on your large-screen, HD monitor.

l Remote Control—you can connect over Ethernet and control networked oscilloscopes from the MAUI Studio
Pro application, including modifying oscilloscope configuration and triggering new acquisitions. Data acquired
on the oscilloscope is automatically pulled into MAUI Studio Pro for analysis, while the oscilloscope is freed for
other tasks.

l Arbitrary Function Generator—MAUI Studio Pro includes an arbitrary function generator that allows you to
simulate seven standard waveforms simply by entering a few properties, or complex waveforms from
equation. Simulated waveforms can be used side-by-side with acquired waveforms.
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Documentation
This manual focuses on describing those features that are unique to MAUI Studio Pro and do not appear in the MAUI
software installed on oscilloscopes.

As the complimentary MAUI Studio will always mimic the user interface and features of the HDO4024A, we
recommend downloading the HDO4000/HDO4000A Operator's Manual from our website for instructions on using all
the standard MAUI features.

As MAUI Studio Pro could potentially "impersonate" any oscilloscope running Windows 7 or Windows 10, we
recommend that you download the Operator's Manual of those oscilloscopes you are most likely to simulate.
Although the vast majority of MAUI features operate the same on all oscilloscopes where they appear, there are
sometimes model-specific differences.

Instructions for using software options are in the various instruction manuals on our website. These are not specific
to any one oscilloscope model.

Visit teledynelecroy.com/support/techlib for all documentation.

Finally, both versions of MAUI Studio include the same online Help as is on the oscilloscope, which contains much of
the same information as is in the Operator's Manuals, including instructions for using software options. From the
menu bar, choose Support > Help Home or Support > Dynamic Help.

Support
In addition to this manual, we have assembled resources to help you get the most out of MAUI Studio Pro on our
website at teledynelecroy.com/mauistudio:

l LabNotebook files are available for download to demonstrate how various software options are unlocked in
MAUI Studio Pro.

l Application Notes provide more in-depth use cases demonstrating MAUI Studio Pro features.

Registered users can also contact Teledyne LeCroy Customer Support for assistance:

Phone (within the U.S.): 800-553-2769

Email: customersupport@teledynelecroy.com

Visit teledynelecroy.com/support/contact for a complete list of regional offices.
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Installing MAUI Studio

Recommended PC Configuration
Operating System: x64 Windows® 10 Pro (required)

Processor: Intel® CoreTM i7 Processor or better, 2.4 GHz or higher

CPU RAM: 4 GB RAM or better

Storage Drive: 2 GB or more available free space for the installed application

Display Resolution: Minimum 1280x780 pixel display, 1920x1080 recommended

Note: The host PC must have an active internet connection to download and register MAUI Studio software.

Remove Old License
If you installed and registered any version of MAUI Studio prior to the April 2021 release, delete the file
C:\LeCroy\XStream\Licenses\HostId.lic from your PC before installing the new MAUI Studio.

Download the Software
1. From the host PC, go to teledynelecroy.com/mauistudio.

2. Click the Download Software button and follow steps to save the installer to the host desktop.

3. Keep your browser open to teledynelecroy.com/mauistudio until registration is complete.

Install the Software

1. On the host PC, double click the installer icon to launch it.

2. Follow the installer prompts, choosing to install MAUI Studio and MAUI Automation Browsers.

Tip: If you run a WavePulser from the host PC, you can also choose to install the latest WavePulser
software at this time.

3. When the installer is done, click Finish and go on to register the MAUI software to activate it.
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Register the Software
Registration is required to activate the MAUI Studio software. You will download and install a license file that
matches the host PC to a set of MAUI capabilities. The PC must have an active internet connection to complete the
registration process.

Follow These Steps if Registering a Free Version or 30-day Trial

1. Launch the MAUI Studio application by clicking the desktop icon or select from the Windows
Start menu MAUI Studio > MAUI Studio.

You should see the Activate MAUI Studio License dialog. Keep this open until you have finished registering.

Tip: If you have closed the dialog, you can find this information by launching the software and going
to Utilities > Utilities Setup on the menu bar, then clicking the Options tab.

2. Open your browser at teledynelecroy.com/mauistudio and click Register Software.

3. If you do not yet have an account, click the New Registration link to create a new account.

If you have a teledynelecroy.com account, follow the Click here to login link and skip to step 6.

4. On the Step 1: Contact Information page, create an account. Be sure to check Opt In at the bottom of the page
so we can send the email containing the verification link. Click the Register button when done.

5



MAUI Studio and MAUI Studio Pro Software Instruction Manual

Note: All fields in red are required. The Register button will not be active until they are filled.

5. When you receive the email containing the verification link, click it. This will take you back to the Login page,
with a link for you to Continue To Next Step.

6. On the registration page, enter the Scope ID, Serial Number and Host ID listed on the Activate MAUI Studio
License dialog into the registration form.

Tip: To avoid errors, click the Copy buttons next to ScopeID, Serial # and HostID on the Activate MAUI
Studio License dialog, then paste it into the registration form.

7. Select the version of MAUI Studio you wish to register, then Submit:

l MAUI Studio (HDO4000A interface only)

l MAUI Studio Pro (Configurable UI, Enhanced LabNotebook, Remote Control, AFG)

8. When you receive the email containing the license key, save the file to the host PC.

9. On the Activate MAUI Studio License dialog, click Load and Activate License file.

10. Using the file explorer, browse to and select the license file, then click Select License File.

Tip: Activating the license can take a few seconds. Be sure to click Select License File only once.
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When registration is successful, the installed license will appear on the Activate MAUI Studio License dialog.

11. Click Close on the Activate MAUI Studio Licesne dialog to restart the MAUI Studio application.

Follow These Steps If Registering an Option Card

1. Launch the MAUI Studio application by clicking the desktop icon or select from the Windows
Start menu MAUI Studio > MAUI Studio.

You should see the Activate MAUI Studio License dialog. Keep this open until you have finished registering.

Tip: If you have closed the dialog, you can find this information by launching the software and going
to Utilities > Utilities Setup on the menu bar, then clicking the Options tab.

2. In your browser, go to teledynelecroy.com/optioncard to enter the required information.
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3. On the Activate your software page, log in, then click Continue to Next Step.

If you do not yet have an account, click the New Registration link at the bottom of the page to create a new
account. You will not be able to proceed without one.

4. On the Step 2: Product Information page, select MAUI Studio Pro, enter the Scope ID, Host ID Serial Number
and Card Code found on the front of your option card, then click Submit.

Tip: To avoid errors, click the Copy buttons next to ScopeID, Serial# and HostID, then paste it into the
registration form.

5. When you receive the email containing the license key, save the file to the host PC.

6. On the Activate MAUI Studio License dialog, click Load and Activate License file.

7. Using the file explorer, browse to and select the license file, then click Select License File.
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Note: Activating the license can take a few seconds. Be sure to click Select License File only once.

When registration is successful, the installed licesne will appear on the Activate MAUI Studio License dialog.

8. Click Close on the Activate MAUI Studio License dialog to restart the MAUI Studio application.

Open Firewall
To use the remote control features of MAUI Studio Pro, be sure that any firewalls on both the PC and the
oscilloscope are open on ports 1861 (VICP port) and 16035.
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Oscilloscope Simulator
After registering MAUI Studio Pro, you can launch it as any of the supported oscilloscope models.

Note: You will be prompted to reconfigure the model type whenever opening a LabNotebook, as will happen
automatically when connecting to a remote oscilloscope if you have selected to Sync Data On Connection.
This procedure shows how to do it independent of those other actions.

1. From the MAUI Studio menu bar, choose Utilities > Configure MAUI Studio.

2. Select the desired Oscilloscope Class and Family from the pop-up dialog.

3. Click Close and OK to restart the application.
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LabNotebook
The complimentary MAUI Studio includes the same LabNotebook features as you will find on the Teledyne LeCroy
oscilloscope you are simulating, including the ability to:

l "Flashback", or restore oscilloscope setups and waveforms to their state at the time the LabNotebook was
saved

l Generate reports from LabNotebook screen images and annotations

l Manage LabNotebook files by appending other files or separating them into component files

l Convert legacy format (.zip) LabNotebooks to .lnb files

MAUI Studio Pro features a new, enhanced version of LabNotebook, which in addition to the above, allows you to
recall the entire "personality" of the oscilloscope on which the LabNotebook was saved when you recall the
LabNotebook. This includes:

l Oscilloscope model type with user interface and standard features (number of channels, memories,
parameters and functions; standard measurements and math; display modes, etc.)

l All software options, including all masks, filters, plots, math and measurements enabled by option

Essentially, to recall a LabNotebook in MAUI Studio Pro is to recall the entire work environment of the source
oscilloscope, enabling you to conduct offline all the same analyses that you would be able to on the oscilloscope,
while freeing the oscilloscope for other tasks.

Colleagues with MAUI Studio Pro who recall these LabNotebook files will also benefit from all the oscilloscope
options, as well as the waveform data, so that LabNotebooks saved and shared become a truly collaborative work
environment.

Apart from the ability to recall oscilloscope model type and options, LabNotebook works exactly the same within
MAUI Studio Pro as does LabNotebook on an oscilloscope. See the oscilloscope Operator's Manual for instructions.

LabNotebook Requirements
To enable the new LabNotebook features in MAUI Studio Pro, you must:

l Install MAUI Studio Pro on the remote PC

l Install MAUI firmware v.9.5.x.x or later on the oscilloscope

l Save the LabNotebook (.lnb) file using MAUI v.9.5.x.x or later

Note: LabNotebook files saved using versions prior to MAUI 9.5 will recall setups and waveform data, as in
MAUI Studio or on the oscilloscope, but they will not recall the source oscilloscope model type or software
options.
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LabNotebook Limitations
l Access to software options persists only as long as the LabNotebook file is recalled. If you close the

LabNotebook, you will have only the standard features of the oscilloscope you are simulating, not options.

l If you recall a different LabNotebook, you will only be able to access features and options saved with that
LabNotebook.

l You cannot transfer options from a LabNotebook file saved in MAUI Studio Pro or on any oscilloscope to
another oscilloscope by opening the LabNotebook file on the second oscilloscope. The "personality" is inherited
only while the LabNotebook file is open in MAUI Studio Pro.

You'll be prompted to reconfigure MAUI Studio Pro when you "flashback" an enhanced LabNotebook. Otherwise, it
works the same as on the oscilloscope.
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Remote Control
You can connect to and control networked Teledyne LeCroy oscilloscopes from any PC with MAUI Studio Pro
installed. To use remote control, the oscilloscope must:

l Be running Windows 10 and MAUI 9.5 or later

l Be set for TCPIP (VICP) remote control (the factory default)

l Have firewall open on ports 1861 (VICP port) and 16035

Any firewall on the PC must also be open on ports 1861 and 16035.

Note: Before connecting to an oscilloscope, confirm the oscilloscope is set for TCPIP (VICP) by navigating
to Utilities > Utilities Setup > Remote on the oscilloscope. This is also where you will find the oscilloscope's
current IP Address. Unless you specifically configure the oscilloscope with a static IP Address on your
network, it will accept a DHCP-provided address.

Remote Connection
To initialize the connection to the oscilloscope:

1. From the menu bar, select File > Remote Scope to display the Remote Scope dialog.

2. Enter the oscilloscope's IP Address or Hostname.

Note: We recommend leaving Sync Data On Connect checked, unless you know the oscilloscope has
a large acquisition that you do not wish to download. Syncing data will pull the acquisition data,
setups and software options from the oscilloscope upon connecting, replicating the oscilloscope
environment within MAUI Studio Pro. If you do not Sync, you may be working with a different set of
capabilities than is on the oscilloscope.

3. Click Connect and wait for the connection process to complete. This can take a few seconds.

Upon connection, your MAUI Studio oscilloscope model should change to that of the connected oscilloscope,
including all of its standard features and software options. The title bar will show the IP address of the
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connected oscilloscope, with the trigger tools added to the right of the menu bar.

Reconfigure Oscilloscope Setups
Once you are connected, you can modify any oscilloscope settings within MAUI Studio exactly as you would using
the software on the oscilloscope. These settings are all explained in the Operator's Manual of the oscilloscope to
which you are connected, and in the various software option manuals.

The only limitation is that you cannot preconfigure a Normal or Auto trigger mode command, although you can make
whatever other trigger setups you like.

To push these setups to the oscilloscope without triggering an acquisition, click Push on the menu
bar or on the Remote Scope dialog. This can be helpful if you wish to remotely configure the oscilloscope in
preparation for a later acquisition with live inputs.
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Trigger Remote Acquisition

To trigger a new acquisition using the current MAUI Studio setups, click Remote Trigger on the menu
bar.

Remote trigger will automatically send all the new setups to the oscilloscope, make a single-shot acquisition, then
stop after taking one full acquisition. You do not need to send the Stop trigger command.

Wait until the acquisition is complete. This can take some time, depending on the size of the acquired waveforms.
You will see a progress message as the transfer occurs.

Any new waveforms, plots or measurement data resulting from the new acquisition will immediately appear in MAUI
Studio.

Pull Data from Oscilloscope

Click the Pull button on the menu bar or Remote Scope dialog to return any setups or data that
may have been left on the oscilloscope following the last new acquisition, particularly if you did not Sync data upon
connecting. As with pushing setups, this can be helpful in cases where you wish to replicate in MAUI Studio analyses
or setups that were performed on the oscilloscope without making a new acquisition.

Note: If the oscilloscope was last triggered in a continuous mode (i.e., Auto or Normal trigger), you will only
see the last full record in the oscilloscope's acquisition buffer at the time you pulled in data. Any cumulative
measurements will show their status as of that acquisition.
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Transfer Files
Files stored on the oscilloscope (e.g., LabNotebooks, masks) can be transferred from the instrument to the MAUI
Studio PC, or vice versa.

From Remote Oscilloscope
1. Connect to the oscilloscope.

2. Click Browse Remote Scope to display the File Browser.

3. Navigate to and select the file you wish to transfer from the oscilloscope. You will have to expand the D: drive
then click on individual folders to see files.

4. Click From Remote, then in the Browse for Folder popup, navigate to the folder on the PC where you'd like to
save the file.

5. Click OK.

6. Wait until the transfer is complete.
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To Remote Oscilloscope
1. Connect to the oscilloscope.

2. Click Browse Remote Scope to display the File Browser.

3. Navigate to and select the folder on the remote oscilloscope where you'd like to save the file.

4. Click To Remote.

5. On the Open popup, navigate to and select the file to transfer, then click Open.

6. Wait until the transfer is complete.
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Signal Generator
The Signal Generator feature included with MAUI Studio Pro allows you to simulate custom sine, square, triangle,
pulse, DC, noise, and arbitrary waveforms on any input channel.

Default Waveforms
MAUI Studio is preset to generate these signals whenever channels C1 through C4 are turned on manually (i.e., not
through importing a LabNotebook or remote control):

C1— Sine Wave, 3 MHz Frequency, 150 mV Amplitude, 0 Offset, 0 Delay, 100 mdiv Gaussian Noise

C2— Square Wave, 3 MHz Frequency, 150 mV Amplitude, 0 Offset, 0 Delay, 100 mdiv Gaussian Noise

C3— Pulse Wave, 3 MHz Frequency, 150 mV Amplitude, 0 Offset, 0 Delay, 100 mdiv Gaussian Noise

C4— Triangle Wave, 3 MHz Frequency, 150 mV Amplitude, 0 Offset, 0 Delay, 100 mdiv Gaussian Noise

Tip: Select Trigger > Auto Setup to modify the channel settings to display these waveforms at full amplitude.

Generate Standard Waveform
Follow these steps to generate a signal of one of the seven standard waveform types.

1. Choose File> Signal Generator, or open the Signal Generator tab of the Channel Setup dialog group.

2. Select the Source channel on which to generate the signal.

3. Choose a Waveform type from Sine, Square, Pulse, Triangle, Ramp, Exponential or DC.

4. Except for DC, enter the Generator settings for waveform Frequency and Amplitude.

5. Optionally,

l Enter any horizontal Delay or vertical Offset from the 0 time and level. These settings are the same as
you would enter on the Channel Setup or Timebase dialogs, but they will apply to only this simulated
signal.

l Enter a modified Rise Time for Square waveforms.

6. To add noise to the simulated waveform:

l Choose a Noise type from Flat, Gaussian or Gaussian Wide.

l Enter size of the noise spike as a part of a division.

7. Repeat Steps 3-6 for any other Source channels on which you'd like to specify a waveform.
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8. Turn on the channel(s) to begin the simulation.

9. To return to the channel's default waveform simulation, select Reset Channel or Reset All channels.

Generate Waveform from Equation
Equations are the most precise way to create a waveform in the Signal Generator, allowing you to define truly
custom and arbitrary waveforms beyond the six predefined types.

See Using Equations to Generate Waveforms for a list of supported functions, operators, variables, constants and
multipliers, and examples of 33 waveforms that can be copied into the Equation Editor and modified to your desired
scale.

1. After selecting the Source channel, select the Waveform type Equation. This will activate the Equation Editor
window.

2. Write your equation in the Equation Editor window, or copy and paste the equation into the window.

Note: Only the final line of any equation is computed; any other lines that are not defined as variables
are ignored. Therefore, equations that span multiple lines should be broken into one variable per line,
with a final line computing the variables. See the image above for an example.

3. Modify the Generator settings as necessary.

Note: The Signal Generator will scale the equation amplitude to the selected Amplitude range. For
example, a 1 V peak waveform will be attenuated to 150 mV if Amplitude is set to 150 mV, and
likewise a 1 V pulse will be amplified to 2 V if Amplitude is set to 2 V.

4. Turn on the channel to begin simulation.

Jitter Simulator
The Jitter Simulator enables you to add custom noise or jitter characteristics to a signal.

See Simulating Data or Clock Jitter.
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Using Equations to Create Waveforms

Functions and Operators
The Signal Generator supports eleven mathematical functions and nine operators, described briefly below. It also
allows the use of variables, fixed arguments and constants within equations.

Functions
ABS ( ) Absolute value, calculates the absolute value, unipolar magnitude, of a function or argument

COS ( ) Cosine, calculates the cosine of the argument

EXP ( ) Exponential, calculates an exponential, using the base of natural logarithms, e, raised to the power specified
in the argument

FLOOR ( ) Floor, calculates the integer floor of a function

LN ( ) Natural Logarithm, calculates the natural logarithm, base e, of the argument or function

LOG ( ) Common Logarithm, calculates the common logarithm, base10, of the argument or function

PULSE ( ) Pulse, creates a unit pulse using edge locations, or functions, specified in the argument

SIN ( ) Sine, calculates the sine of the argument

SQRT ( ) Square root, calculates the square root of the argument or function

STEP ( ) Step, creates a unit step at the location specified by the argument or function

TAN ( ) Tangent, calculates the tangent of the argument

Operators
+ Addition

- SubtractionU

* Multiplication

/ Division

^ Raise to power (exponentiation)

= Equals

( ) Mathematical grouping

, Comma, separator for arguments
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Variables
The variables X1 to X16 followed by the equal sign can be used to label the contents of any line of the Equation
Editor. The variable label can then be used to replace the contents in another equation. For:

X1=SIN(2*PI*10E6*T)
X2=(1+0.75*COS(2*PI*1E3*T))
X1*X2

The product X1*X2 will be computed as:

SIN(2*PI*10E6*T)*(1+0.75*COS(2*PI*1E3*T))

Note: Only the final line of any equation is computed; any other lines that are not defined as variables are
ignored. Therefore, equations that span multiple lines should be broken into one variable per line, with a final
line computing the variables, as shown above.

In general, you can think of equations as one function per line/variable, with the exception of the PULSE function.
Since it acts as a gating function/multiplier, it is best kept on the same line as the other expressions on which it
operates.

Arguments
There are five functional arguments available for use in equations:

2*PI*T Phase variable for trigonometric functions, in radian seconds

T Time variable, in seconds

PI Numerical constant 3.14159265358979

NOISE Uniformly distributed random numbers 0-1, mean = 0.5, standard deviation = 0.288

GNOISE Gaussian distributed random numbers 0-1, mean = 0.5, standard deviation = 0.1667

Multipliers
Standard multipliers are supported: p (pico, 1E-12); n (nano, 1E-9); µ or u (micro, 1E-6);
m (milli, 1E-3); k (kilo, 1E3); M (Mega, 1E6).

You need only enter the multiplier (where relevant) and value when specifying a waveform; the unit of measure for
each function and argument is assumed.

Equations
Following is a list of generic equations showing the functions, constants, arguments and variables used to create
that waveshape. User-entered constants are described in general terms.

Accompanying each is an example equation that would create the waveform shown in the image, assuming:
channel vertical scale 500 mV/division; horizontal scale 1 µs/division with -5 µs delay; Signal Generator Amplitude 1
V. Note that using another Generator setting will alter waveforms by a factor (G), the ratio of the Amplitude setting
compared to 1 V.
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Unit Step
STEP(T-To)

To - Edge location, seconds

For example, the equation: STEP(T-3µ)

Produces...

Time Reversed Unit Step
STEP(To-T)

To - Edge location, seconds

For example, the equation: STEP(3µ-T)

Produces...
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Unit Pulse
PULSE(T1,T2)

Or

STEP(T-T1)-STEP(T-T2)

T1 - Time of leading edge, seconds
T2 - Time of trailing edge, seconds

For example, the equation: PULSE(3µ,7µ)

Produces...

Pulse Train
STEP(SIN(2*PI*T*FS))

FS - Pulse frequency, Hertz

For example, the equation: STEP(SIN(2*PI*T*1M))

Produces...

The function STEP ( ) accepts other functions as an argument, f (T),where:

STEP(f (T)>0)=1

STEP(f (T)<0)=0
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Tri-level Pulse
PULSE(T1,T2)-PULSE(T3,T4)

T1,T3 - Time of leading edges, seconds
T2,T4 - Time of trailing edges, seconds
T4>T3, T3>T2, T2>T1

For example, the equation: PULSE(3µ,4µ)-PULSE(5µ,6µ)

Produces...

Ramp
A*T

A - Slope of ramp, Volts/second

For example, the equation: 0.2M*T

Produces...
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Delayed Ramp
A*(T-TD)*STEP(T-TD)

A - Slope of ramp, Volts/second
TD - Time delay, seconds
For example, the equation: 0.2M*(T-2.5µ)*STEP(T-2.5µ)

Produces...

Truncated Ramp
A*(T-TD)*PULSE(TD,TL)

A - Slope of ramp, Volts/second
TD - Time delay, seconds
TL - Length of ramp, seconds

For example, the equation: 0.2M*(T-2.5µ)*PULSE(2.5µ,7.5µ)

Produces...
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Truncated Negative Ramp
-A*(T-TD)*PULSE(TD,TL)

A - Slope of ramp, Volts/second
TD - Time delay, seconds
TL - Length of ramp, seconds

For example, the equation: -0.2M*(T-2.5µ)*PULSE(2.5µ,7.5µ)

Produces...
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Trapezoidal Pulse with Adjustable Transition Times
X1=-A*(T-T1)*STEP(T-T1)

X2=A*(T-T2)*STEP(T-T2)

X3=A*(T-T3)*STEP(T-T3)

X4=-A*(T-T4)*STEP(T-T4)

X1+X2+X3+X4

A - Edge slope, Volts/second
T1 - Leading edge start time, seconds
T2 - Leading edge end time, seconds
T3 - Trailing edge start time, seconds
T4 - Trailing edge end time, seconds

For example, the equation:

X1=-10M*(T-3µ)*STEP(T-3µ)

X2=10M*(T-3.1µ)*STEP(T-3.1µ)

X3=10M*(T-7µ)*STEP(T-7µ)

X4=-10M*(T-7.1µ)*STEP(T-7.1µ)

X1+X2+X3+X4

Produces...
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Sine
V*SIN(2*PI*T*FS)

V - Signal amplitude, Vpeak
FS - Signal frequency, Hertz

For example, the equation: 1.5*SIN(2*PI*T*0.5M)

Produces...

Gated Sine
V*SIN(2*PI*T*FS)*STEP(T-TG)

V - Signal amplitude, Vpeak
FS - Signal frequency, Hertz
TG - Gate start time, seconds

For example, the equation: 1.5*SIN(2*PI*T*0.5M)*STEP(T-3µ)

Produces...
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Signal Generator

Sine Burst
V*SIN(2*PI*T*FS)*PULSE(TS,TE)

V - Signal amplitude, Vpeak
FS - Signal frequency, Hertz
TS - Burst start time, seconds
TE - Burst end time, seconds

For example, the equation: 1.5*SIN(2*PI*T*0.5M)*PULSE(2µ,8µ)

Produces...

Decaying Exponential
EXP(-T/TC)

TC - Time constant, seconds

For example, the equation: EXP(-T/2µ)

Produces...
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Delayed Exponential Decay
EXP(-(T-TD)/TC)*STEP(T-TD)

TD - Time delay, seconds
TC - Time constant, seconds

For example, the equation: EXP(-(T-3µ)/2µ)*STEP(T-3µ)

Produces...

Rising Exponential
1-EXP(-T/TC)

TC - Time constant, seconds

For example, the equation: 1-EXP(-T/2µ)

Produces...
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Signal Generator

Delayed Rising Exponential
(1-EXP(-(T-TD)/TC))*STEP(T-TD)

TD - Time delay, seconds
TC - Time constant, seconds

For example, the equation: (1-EXP(-(T-3µ)/2µ))*STEP(T-3µ)

Produces...
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Exponential Pulse with Different Rise/Fall Constants
X1=(1-EXP(-(T-T1)/T2))*PULSE(T1,T3)

X2=(EXP(-(T-T3)/T4)*STEP(T-(T3+T5))

X1+X2

T1 - Delay of rising edge, seconds
T2 - Time constant of rise, seconds
T3 - Delay of falling edge, seconds
T4 - Time constant of fall, seconds
T5 – Sample period, seconds

For example, the equation:

X1=(1-EXP(-(T-2µ)/0.5µ))*PULSE(2µ,5µ)

X2=(EXP(-(T-5µ)/1µ)*STEP(T-5.0001µ))

X1+X2

Produces...
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Signal Generator

Exponentially Damped Sine
V*EXP(-T/TC)*SIN(2*PI*T*FS)

V - Signal amplitude, Vpeak
TC - Time constant, seconds
FS - Signal frequency, Hertz

For example, the equation: 2*EXP(-T/2µ)*SIN(2*PI*T*2M)

Produces...

Gaussian Pulse
EXP(-(1/2)*((T-TM)/Ts)^2)

TM - Time location of center or mean of Gaussian pulse
Ts - Half width of Gaussian, point corresponds to standard deviation, s

For example, the equation: EXP(-(1/2)*((T-5µ)/1µ)^2)

Produces...
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Amplitude Modulation
X1=SIN(2*PI*T*FC)

X2=(1+K*f(T))

X1*X2

FC - Carrier frequency, Hertz
K - Modulation index, 0<K<1
f (T) - Modulating waveform, a function of T, such as COS(2*PI*T*FM)
FM - Modulation frequency, Hertz

For example, the equation:

X1=SIN(2*PI*T*2M)

X2=(1+0.85*COS(2*PI*T*0.2M))

X1*X2

Produces...
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Signal Generator

Sine Amplitude Sweep
(A*T)*SIN(2*PI*T*FS)

A - Slope of ramp, Volts/second
FS - Signal frequency, Hertz

For example, the equation: 0.2M*T*SIN(2*PI*T*1M)

Produces...

Frequency Modulation
SIN(2*PI*T*FC+(FD/FM)*COS(2*PI*T*FM))

FC - Carrier frequency, Hertz
FD - Frequency deviation, Hertz
FM - Modulation frequency

For example, the equation: SIN(2*PI*T*2M+2*COS(2*PI*T*0.4M))

Produces...
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Linear Frequency Sweep
SIN(PI*(2*T*FS+((FE-FS)/TS)*T^2))

FS - Start frequency, Hertz
FE - End frequency, Hertz
TS - Sweep duration, seconds

For example, the equation: SIN(PI*(2*T*1M+((4M-1M)/10µ)*T^2))

Produces...

Logarithmic Frequency Sweep
X1=LN(FE/FS)/TS

SIN(2*PI*((FS/X1)*(EXP(X1*T)-1)))

FE - End frequency, Hertz
FS - Start frequency, Hertz
TS - Sweep duration, seconds

For example, the equation:

X1=LN(10M/1M)/10µ

SIN(2*PI*((1M/X1)*(EXP(X1*T)-1)))

Produces...
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Signal Generator

Phase Modulation
SIN(2*PI*T*FC+K*SIN(2*PI*T*FM))

FC - Carrier frequency, Hertz
K - Peak phase excursion, radians
FM - Modulation frequency, Hertz

For example, the equation: SIN(2*PI*T*2M+PI/2*SIN(2*PI*T*0.4M))

Produces...
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Pulse Width Modulation
X1=SIN(2*PI*T*FC+K*COS(2*PI*T*FM))

X2=SIN(2*PI*T*FC+K*SIN(2*PI*T*FM))

STEP(X1)*STEP(X2)

FC - Pulse frequency, Hertz
K - Peak phase excursion, radians
FM - Modulation frequency, Hertz

For example, the equation:

X1=SIN(2*PI*T*1M+PI/2*COS(2*PI*T*0.1M))

X2=SIN(2*PI*T*1M+PI/2*SIN(2*PI*T*0.1M))

STEP(X1)*STEP(X2)

Produces...
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Signal Generator

Pulse Amplitude Modulation
A*T*STEP(SIN(2*PI*T*FC)

A - Slope of ramp, Volts/second
FC - Pulse frequency, Hertz

For example, the equation: 0.2M*T*STEP(SIN(2*PI*T*1M))

Produces...

Lorentz Pulse
1/(1+((T-TD)/TW)^2)

TD - Time delay, seconds
TW - Half width @ 50% amplitude, seconds

For example, the equation: 1/(1+((T-5µ)/0.5µ)^2)

Produces...
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Full Wave Rectified Sine
ABS(SIN(2*PI*T*FS))

FS - Signal frequency, Hertz

For example, the equation: ABS(SIN(2*PI*T*1M))

Produces...

Half Wave Rectified Sine
X1=Sin(2*PI*T*FS)

X2=STEP(X1)

X1*X2

FS - Signal frequency, Hertz

For example, the equation:

X1=SIN(2*PI*T*1M)

X2=STEP(X1)

X1*X2

Produces...
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Signal Generator

Gated Sine-variable Duty Cycle
X1=TD

X2=SIN(2*PI*T*FS)

X3=SIN(2*PI*(T-X1)*FS)

STEP(X2*X3)*X2

TD - Delay time, seconds
FS - Signal frequency, Hertz
For example, the equation:

X1=0.15µ

X2=SIN(2*PI*T*1M)

X3=SIN(2*PI*(T-X1)*1M)

STEP(X2*X3)*X2

Produces...
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Additive Noise Burst
X1=SIN(2*PI*T*FS)

X2=(NOISE-0.5)*PULSE(T1,T2)

X1+X2

FS - Signal frequency, Hertz
T1 - Start time of noise burst, seconds
T2 - End time of noise burst, seconds

For example, the equation:

X1=SIN(2*PI*T*100k)

X2=(NOISE-0.5) *PULSE(5u,5.5u)

X1+X2

Produces...
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Signal Generator

Simulating Data or Clock Jitter
The JitSim feature allows you to simulate waveforms with custom data and jitter characteristics in addition to the
basic signal characteristics that you can create using the pre-defined waveforms or the Equation Editor. This helps
you recreate "problem" signals needed to test equalizers or other signal conditioners, filters and masks, or to
measure S-parameters for circuit emulation.

To access the setup dialogs, choose JitSim on the Signal Generator dialog, then click Advanced Data Sim. The
settings will be immediately applied to the source signal being configured.

Sim. Signal Tab
Use this tab to define the primary/carrier signal characteristics.

1. Choose the signal Type to simulate:

l Clk for a clock signal

l Sinusoid or pulse-modulated (PulseMod) waveform (with no data characteristics)

l Data signal of the type NRZ, RZ, bp RZ, PWM, PAM3 or PAM4

2. In Freq or Bit Rate, enter the frequency of periodic signal types or the bit rate of data signals.

3. Enter the desired:

l Amplitude, one half the Peak-Peak voltage

l Positive or negative Vertical Offset from level zero

l 10-90% Risetime and Rise:Fall ratio

l Rate X...

4. To apply a low pass Butterworth filter to the signal, check BWL On and enter the frequency CutOff and filter
Order.

Jitter Tab
Use the Jitter tab to add either broadband or sinusoidal jitter to the base signal. You can also use settings on the
Rand. Gen. tab to randomize the jitter patten.

Broadband Jitter
Check On beneath Simulated Broadband Jitter and enter the Rj, BUj, and BUj Shape characteristics.

Sinusoidal Jitter

1. Clear the On box under Broadband jitter if it is checked.

2. Enter the Jitter Freq(uencies) being modulated and the amount of modulation in Pk-Pk.

3. To turn on Spread System Clocking:

l Check SSC On and enter the SSC Freq(uency) for each of the three jitter frequencies.

l Choose a Mod(ulation) Shape.
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Rand. Gen. Tab
The jitter algorithm uses a random number generator to ramdomize the jitter. To modify the pattern used to
randomize the jitter, change the Seed sequence, or check one of the randomizing selections.

Vertical (Noise) Tab
On the Vertical tab, enter any vertical noise characteristics or other vertical shape attributes, such as +/- Overshoot
or Edge Spike.

Data (Pattern) Tab
If the signal is one of the data types, such as NRZ:

1. Select the Data Type and any Data Pattern, Pattern Length or Sequence relevant to that type.

2. To define frames, check Frame on and enter the Frame Pattern and Frame Length.

3. Optionally, check Pattern Lock to generate the same pattern at the start of every "trigger." This will stabililze
the pattern on the screen. Otherwise, the pattern is randomized.

4. Optionally, check Invert Pattern to invert the signal.

5. To introduce bit rate errors, enter the Error Rate and the first Error Bit.
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